Group Microsite Manual

A How-To Guide for the Management of SAA Component Group “Microsites”

Updated by Cherie Newell, SAA Web and Information Services Administrator
Available online at http://www2.archivists.org/governance/leaderresources.
# Table of Contents

Introduction ............................................................................................................................................ 3  
Introduction to “Nodes” and “Content Types”................................................................................... 3  
Microsite Editing Permissions for Group Leaders............................................................................... 3  
Non-SAA Websites and Social Media.................................................................................................. 3  
Questions? .......................................................................................................................................... 3  

Getting Started........................................................................................................................................ 4  

Your Group Homepage ........................................................................................................................... 4  
  Editing the Group Homepage ............................................................................................................. 6  
  Hide Automatic Display of Group Nodes (“Auto-links”)................................................................. 6  

General Functions ................................................................................................................................... 7  
  Add Node ............................................................................................................................................ 7  
  Edit Node............................................................................................................................................. 7  
  Revisions ............................................................................................................................................. 7  
  Formatting and Editing ....................................................................................................................... 7  
  Inserting and Editing Images ............................................................................................................... 8  
  Promote to Group Front Page and SAA News Feed............................................................................ 8  
  Public vs. Private Content ................................................................................................................... 9  
  File Attachments ................................................................................................................................. 9  
  Comment Settings ............................................................................................................................... 9  

Content Type Descriptions .................................................................................................................... 10  
  Group Menus .................................................................................................................................... 10  
    Editing Group Menus ..................................................................................................................... 10  
  Group News Items ............................................................................................................................... 11  
  Group Pages ..................................................................................................................................... 11  
  Group Newsletters .............................................................................................................................. 11  
  Group Reports................................................................................................................................... 11  
  Group Meetings................................................................................................................................ 11  
    Meeting Agendas .......................................................................................................................... 12  
    Agenda Items .................................................................................................................................. 12  
    Meeting Minutes ............................................................................................................................ 12  
  Group Logos ...................................................................................................................................... 12  

Appendix: Advanced Privacy Settings ................................................................................................... 13
Introduction

This manual contains guidelines for managing component group “microsites” in SAA’s Web content management system, Drupal. Microsites are created by SAA staff and linked automatically to the official group description as well as the current group rosters, which are managed by the member database.

Introduction to “Nodes” and “Content Types”

Every webpage administered in Drupal is called a node. There are various types of nodes, called content types, which are used for specific purposes (e.g., “Page,” “News Item,” “Group Menu,” or “Meeting Minutes”).

Microsite Editing Permissions for Group Leaders

All group leaders (for most groups, this is the steering committee) are given access to edit the microsite by default. We recommend that groups designate one or two members to act as “web liaison,” whether formally or informally, to manage microsite content.

SAA staff manages group rosters in the member database, which controls permissions to edit the microsites. Group leaders should ensure that they provide updated roster information to SAA staff.

Non-SAA Websites and Social Media

The main SAA website is the best place for people to find your group, and so you should consider the microsite your group’s online home, even (and especially) if you are using other online resources beyond those provided by SAA.

Component groups are encouraged to create or use external web resources (including social media) as desired. Such sites/accounts must adhere to guidelines in the Uniform Guidelines for SAA Websites and Online Communications. It is a best practice to list/link to all auxiliary sites on the group’s microsite.

For sections, it is also a best practice to use your group’s official logo (see p. 12) whenever possible.

Questions?

Email the SAA Leaders Discussion List (archivists-saaleaders@ConnectedCommunity.org) to get help from fellow leaders and web liaisons, or contact SAA Web and IT Administrator Cherie Newell (cnewell@archivists.org, 312-606-0722 x17).
Getting Started

There are two ways to navigate to your microsite’s homepage, starting at www2.archivists.org:

1. Navigate to your group via Membership > Groups.
2. Click on your group category (Committees, Sections, etc.)
3. Click on your group’s name.

Or

1. Log in to the SAA website (“Login” link in top right corner) with your SAA Profile;
2. Click “My Account” in the top right corner of the screen;
3. Click on your group’s name under your list of groups.
   (If you do not see a link, you may need to have your leader role activated by SAA staff. Email Cherie Newell at cnewell@archivists.org for additional assistance.)

Your Group Homepage

Your microsite homepage contains the following elements (see Figure 1):

1) The group name/page title.
2) Navigation links, that are generated automatically.
3) Introductory/welcome text (Full Group Description).
4) A “Recent News & Announcements” feed that displays News Items in reverse chronological order.
5) Related Group Content box. (See Hide Automatic Display of Group Nodes [“Auto-links”] below.)
   Note that this menu is paginated, and you may need to use the page controls at the bottom of the box to find your content.
6) Short links to content by content type.
7) Group Logo.
8) An administrator menu.
9) Link to Group Logos page.
10) Group Menus (custom).
11) Links to Leader Resources (shows only to logged-in group leaders).
Figure 1. Example of a component group homepage, as viewed by an editor. Display of “View” and “Edit” tabs and administrator menu items is contingent on user permissions.
Editing the Group Homepage

Editors may edit introductory/welcome text published on the homepage and access other administrative settings associated with the entire microsite by clicking on the “Edit” tab at the top of the group homepage. (Tabs appear immediately below the group name/page title when you are logged in.)

Group homepage fields include:

- **Theme:** Use of the “SAA Theme” is strongly recommended.
- **Description:** You may leave this field as is.
- **Full Group Description:** The contents of this field correspond to your introductory/welcome message. Enter content to greet your visitors. We recommend a succinct greeting because extensive text will push the other content further down the page.
- **Hide Automatic Display of Group Nodes:** See below.
- **Header/Footer:** The header and footer fields are intended for creating custom page templates using the “Blank Theme” option. It is recommended that these fields be left blank.
- **Comment Settings:** Disabled by default (recommended).
- **File Attachments:** Generally files are attached to other microsite nodes. However, they are also supported on the group homepage if desired.

![Figure 2: Hide Automatic Display of Group Nodes on homepage edit tab.](image)

**Hide Automatic Display of Group Nodes (“Auto-links”)**

Links to group content appear at the bottom of all nodes in your microsite. They are arranged in reverse chronological order by content type and cannot be rearranged. To give Editors more flexibility in controlling microsite navigation, the checkbox labeled “Hide Automatic Display of Group Nodes” places
these links in a gray box that is visible only to group administrators (Figure 2). If you decide to use this option, customized Group Menus should be created to direct users to your content.

**General Functions**
The following functions are common to many group content types:

**Add Node**
Click the “add” links in the right-hand administrator menu to create nodes according to content type.

**Edit Node**
Editors will see “View” and “Edit” tabs at the top of nodes. Click the Edit tab to access the editing tools.

**Revisions**
Every time you edit and save a node, a copy of the old version is recorded automatically. You may also enter a log message for internal reference purposes. Prior versions, if applicable, may be accessed via the “Revisions” tab. Please note, however, that prior versions of the group homepage are not maintained.

**Formatting and Editing**
Most content types feature at least one long-text field with a WYSIWYG\(^1\) formatting toolbar (Figure 2). This toolbar may be used for relatively simple formatting, such as boldface, italic, bullet lists, numbered lists, indentation, and editing of static hyperlinks.

**Tips for Using the Formatting Toolbar Effectively:**

- When pasting text from Word, be sure to use the **Paste from Word** icon to strip out incompatible code.
- Use the eraser icon to **Remove Formatting** applied in external applications. This may require reapplication of your desired formatting.
- Use the **Format** drop-down menu to apply standardized styles (e.g., H2, H3, etc.) for headers and sub-headers.

**Input Format:** Two editing modes may be used:

1. **Filtered HTML** (recommended) is the default that displays the toolbar.
2. **Full HTML** enables you to edit your markup code directly. **Tip:** Nodes edited in Full HTML must be saved in that mode for some tags to render. Changing input formats will “filter” them out.

---

\(^1\) “What you see is what you get” (WYSIWYG).
Inserting and Editing Images

The formatting toolbar features an icon that allows you to easily insert and edit inline images. The icon looks like a tree (Figure 3). Images are inserted at your cursor’s location. Clicking on the icon opens a dialog box in which you can set the image URL, description, alignment, dimensions, border, and vertical/horizontal space to appear around the image (i.e., the gutter).

To the right of the Image URL field is a “Browse” icon. Clicking this icon opens another dialog box that displays your individual user folder in Drupal. You may use the “Upload” link to upload image files from your local drive. Uploaded files may be highlighted and inserted into your node by clicking on the “Insert” link. Upon returning to the “Insert/edit image” dialog box, you will notice that the Image URL field is now populated with the absolute path to your image in Drupal. Click again on the “Insert” button to return to your node edit screen. You will now see your image in the WYSIWYG text field.

Promote to Group Front Page and SAA News Feed

Links to News Items, Newsletters, Reports, and Meetings nodes are displayed automatically in reverse chronological order on your group homepage and on the Global SAA Newsfeed at http://www2.archivists.org/newsfeed if and when the checkbox on the node edit screen is checked (default). Items can also be designated as “sticky” under Publishing Options, found at the bottom of the node edit screen. Sticky nodes will remain at the top of your homepage feed above other more recently created content. This feature is helpful for temporarily highlighting important content.
Public vs. Private Content

The SAA website is designed to be a public site and to make materials accessible and discoverable. Content and files uploaded to the site should not contain important confidential information.

If your group requires a secure online environment in which to collaborate, we recommend Google Drive or a similar site with rigorous security protocols in place. The procedures below allow users to “hide” some content from the general public, but these are not secure from hackers or malicious attacks.

Under the “Groups” header on the node edit screen is a checkbox labeled “Public” (Figure 4). Check this box to make the node appear to users outside of your group leadership.

![Figure 4. The “Public” checkbox on the node edit screen.](image)

If you leave unchecked the checkbox labeled “Public,” links to the node will not display in your News Feed or in the auto-links block for public users. Such links will appear for your group leaders and for staff. There are two limitations to this method:

- Static links embedded in other group nodes or on external sites are unaffected by the “Public” checkbox setting.
- Actual access to the node is not restricted. If a public user browses to your private node via a static link or by typing the URL directly into her browser, the content will display. Therefore, confidential information should not be managed via this method.

If you want to enable stricter privacy on a node, see Appendix: Advanced Privacy Settings.

File Attachments

Use this feature to upload and display file attachments with the node.

Comment Settings

Specify whether authenticated users may read and/or add Comments to the node.
Content Type Descriptions

Group Menus
Editors can create and edit any number of Group Menus, each of which has its own name and any number of sortable links. Group menus display in the right sidebar of your microsite. Group Menus themselves may also be sorted via the **Node Weight** control on the menu’s Edit tab. Smaller weights will appear above larger weights.

**Note:** URLs in group menu items must be managed manually. If a node’s URL changes (which happens automatically if the node’s title changes), the link in the group menu will not update automatically, and the link will likely break.

**Editing Group Menus**
Group menus are themselves a particular type of node, and are edited using a similar procedure.

1. Click on the short link to the “Group Menu” content type at the bottom of the page. Usually this is in the gray box titled “Related Group Content” (Figure 5).

![Figure 5: Short links at bottom of “Related Group Content” box.](image)

2. The Group Menu page will list all of your microsite’s group menus by name. Click on the menu you want to edit.
3. The Group Menu will be displayed in the body of the node. Click the Edit Tab (Figure 6).
4. Edit link text and URLs as desired. Click Save.

**Group News Items**
Group News Items are designed for announcements and updates that you want to share with the public. Group News Items may be added to your homepage feed.

**Group Pages**
Group Pages are for permanent or semi-permanent content. Group Pages may not be added to your homepage feed. **Group Pages should not be used to duplicate information that is maintained by staff in the member database or elsewhere in Drupal—e.g., leader rosters, member rosters, SAA Governance Manual content, etc.**

**Group Newsletters**
Group Newsletters are designed for the official newsletter of a group. Group Newsletters may be added to your homepage feed.

**Group Reports**
Group Reports are designed for official reports of the group. Group Reports may be added to your homepage feed.

**Group Meetings**
Group Meetings are designed to be the parent object that contains meeting agendas and minutes. Group Meetings may be added to your homepage feed.

The child types of a group meeting are optional, but allow for detailed organization of your meetings.
Meeting Agendas
Meeting Agendas are linked to a “parent” group meeting. The meeting agenda content type is configured to display hyperlinks to agenda items dynamically.

Agenda Items
Agenda Items are designed for individual items that will link automatically to the Meeting Agenda.

Meeting Minutes
Meeting Minutes are linked to a “parent” group meeting. Links to referenced meeting minutes are displayed dynamically on the Group Meeting node.

Group Logos
SAA Sections are provided with professionally designed logos that integrate SAA’s branding. Logos were designed with social media, blogs, and other modern web applications in mind. High-resolution versions are available for print applications. You can access your Section’s logos through your microsite’s administration menu (see Figure 1, #9).
Appendix: Advanced Privacy Settings

All group content types have been configured with per-node access control. Editors have permission to use these settings, which are managed via the “Access Control” tab displayed to the right of the “Revisions” tab (Figure 7).

![Access Control Screen]

Figure 7. The Access Control screen.
This screen allows Editors to override the standard node permissions. These controls supersede the Public checkbox setting and should be used as follows. (Note: Numbers below correspond to labels in Figure 7.)

1. Under “View any content,”
   a. To remove view permission granted to all public users (default), uncheck **anonymous user** and **authenticated user**.
   b. To grant view permission only to your group leaders, check **group contributor**, **group editor**, and **group officer** under “View any content.” This re-grants view permission to your group leaders. (Note: You may ignore group manager. That role is not used.)
   c. To grant view permission only to SAA members, check the **saa member** role under “View any content.”

2. Uncheck **anonymous user** and **authenticated user** under “View own content.” This is a further precaution to ensure the content is not publicly viewable.

3. **DO NOT ALTER** any settings labeled “Edit * content” or “Delete * content.” Changing these controls risks unauthorized modification to and/or deletion of your content!